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CHAPTER 1

Introduction

1.1 PURPOSE

IMPORTANT: onsemi acknowledges that this document might contain the inappropriate terms “white list",
"master" and "slave”. We have a plan to work with other companies to identify an industry wide solution
that can eradicate non-inclusive terminology but maintains the technical relationship of the original wording.
Once new terminologies are agreed upon, future products will contain new terminology.

This manual describes Firmware Over-The-Air (FOTA) with RSL10. It provides the prerequisites and instructions
necessary to develop FOTA-ready firmware applications and to perform FOTA updates in the field.

1.2 INTENDED AUDIENCE

This manual is for firmware developers who are designing and implementing RSL10 applications with FOTA
capability.

1.3 CONVENTIONS
The following conventions are used in this manual to signify particular types of information:

monospace font
Macros, functions, defines and addresses.

italics
File and path names, or any portion of them.

<angle brackets>
Optional parameters and placeholders for specific information. To use an optional parameter or
replace a placeholder, specify the information within the brackets; do not include the brackets
themselves.

1.4 FURTHER READING

For more information about RSL10, refer to the following documents:

* RSLI0 Hardware Reference

* RSLI0 Firmware Reference

¢ RSLI10 Getting Started Guide

® RSLI0 Sample Code User’s Guide

® RSLI0 Evaluation and Development Board Manual
* RSLI0 Datasheet
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CHAPTER 2

Overview

2.1 PREREQUISITES

* RSL10 SDK CMSIS-Pack version 2.4.0 or later (available at www.onsemi.com)
* RSL10 USB Dongle
* RSL10 Evaluation and Development Board (EVB)
¢ RSL10 Bluetooth Low Energy Explorer (available at www.onsemi.com)
* Python v2.7 or later:
o Install package ecdsa version 0.13 or later.
o Install package pyserial version 3.2 or later.
© Make sure Python is added to the system path.
° You can install the above packages using PyPI (for example, python -m pip install ecdsa).

* Fota.Console tool (available in the utility apps zip package), which has the following dependencies:
° Microsoft™ .Net Framework version 4.6 or later
° SiliconLabs™ VCP driver version 6.7.3 or later (available in the RSL10 Bluetooth Low Energy Explorer
installation, onsemi/BLE Explorer/Driver/RSL10_Dongle Driver v<version>.zip)

Or the mobile application, as an alternative to the Fota.Console tool (see Chapter 9 "RSL FOTA Mobile
Application" on page 40).

2.2 OVERVIEW

The RSL10 software ecosystem includes a set of tools that allows Firmware Over-The-Air (FOTA) updates from a
PC with the RSL10 USB dongle to a remote RSL10 device over a Bluetooth Low Energy wireless link. On the PC side,
a Python utility (mkfotaimg.py) generates FOTA-compatible firmware images and a PC command line tool
(FOTA.Console.exe) transfers the images to the remote device. The PC command line tool uses the RSL10 USB Dongle
as a central device to scan, connect and transmit the firmware image. The remote RSL10 device firmware side consists
of a bootloader program, sample code, and a FOTA Bluetooth Low Energy stack that contains the Device Firmware
Update (DFU) Bluetooth Low Energy component. The figure "FOTA Update Setup" (Figure 1) illustrates a typical
FOTA update setup from the PC point of view:

RSL10 SDK
app.bin, fota.bin

app.fota

3

RSL10 7z 7~ RSL10
EVB N N

1 Dongle
»

mkfotaimg.py

app.fota

FOTA.Console.exe

Figure 1. FOTA Update Setup
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The following chapters provide details about the tools, protocols and firmware required to perform FOTA updates
using RSL10. We present details about the FOTA firmware images and tools, walk you step-by-step through your first
firmware update using a pre-configured sample application (ble_peripheral _server hrp_fota), and show how to modify
an existing application to support FOTA updates.

www.onsemi.com
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CHAPTER 3

The FOTA Firmware

3.1 FOTA PARTITIONING

A device capable of receiving FOTA updates contains firmware composed of three parts, as illustrated in the figure
"Memory Map" (Figure 2):

1. Bootloader
2. FOTA Bluetooth Low Energy stack including DFU component (fota.bin sub-image)
3. User application (app.bin sub-image)

Bootloader

BLE Stack Area
(fota.bin)

DFU

Padding up to 2KB

Application area
(app.bin)

Figure 2. Memory Map

Each part depends on the previous one, except the bootloader, which is standalone. The FOTA Bluetooth Low
Energy stack depends on the bootloader. The user application depends on the FOTA Bluetooth Low Energy stack, and
therefore, also depends on the bootloader. In terms of size, the bootloader reserves 8KB of memory. The Bluetooth
Low Energy stack, which contains the Device Firmware Update (DFU) component and the padding between the sub-
images, allocates about 154KB. The remainder of the RSL10 main flash memory is available for the application
(380KB - 154KB - 8KB approximately equal to 218KB). The boundary between the Bluetooth Low Energy stack and
application areas can be dynamic, so it is possible to increase the Bluetooth Low Energy stack size at the expense of the
application size, and vice versa.
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When building a FOTA-compatible RSL10 sample application, you may notice that the libfota.a library is linked.
This library functions as a stub object, and implements the Bluetooth Low Energy library functions as pointers to the
real implementation, located in the fota.bin area. This makes the link between the application and the FOTA Bluetooth
Low Energy stack particularly strong, because the application code calls functions from the Bluetooth Low Energy
stack directly. Therefore, an application can only run together with the specific FOTA Bluetooth Low Energy stack
revision that is used when building that application. For this reason, it is not possible to update the Bluetooth Low
Energy stack without updating the application. On the other hand, it is possible to perform a FOTA update of the user
application only.

Two types of FOTA updates are possible:

* Application only update
* Application + FOTA Bluetooth Low Energy stack update

The DFU component, an application embedded in the Bluetooth Low Energy stack area, implements a DFU
Bluetooth Low Energy custom service for FOTA updates. It contains characteristics that allow a client device to gather
information from the installed firmware (such as version numbers and IDs) and download the firmware image. As the
DFU is embedded into the FOTA Bluetooth Low Energy stack area, FOTA updates are possible even when no valid
user application is available in the device. More details about this component are provided in Chapter 6.1 "DFU
Component" on page 22.

3.2 FIRMWARE STARTUP

Upon boot-up, the bootloader checks whether there is a valid user application or Bluetooth Low Energy stack
programmed. The sequence of operations is as follows:

1. If there is a valid user application, start it.

2. If no valid application is found, start the FOTA Bluetooth Low Energy stack DFU component (so the device can
receive FOTA updates).

3. If no valid FOTA Bluetooth Low Energy stack is found, start the bootloader updater (in this case, the device can
only receive firmware updates over UART/USB).

The FOTA Bluetooth Low Energy stack DFU component can be activated from the user application at any time,
through a call to Sys_Fota StartDfu (). More details about this are provided in later chapters.

3.3 APPLICATION ONLY UPDATE

To update the application, the currently installed user application needs to start the DFU component from the
Bluetooth Low Energy stack. The DFU component then starts the FOTA process and receives the new application
image. The application image embeds the Build ID, calculated by the GNU linker over all symbols of fota.bin (see the
table "DFU Service Characteristics and their Properties" (Table 4) for more about the FOTA stack Build ID). If this
information does not match the installed Bluetooth Low Energy stack revision, the FOTA update is aborted. At this
point the currently installed application is not destroyed.

If the Bluetooth Low Energy stack revision is compatible, the currently installed application is erased and the new
image is programmed as the data comes in. When the whole image is programmed successfully, the DFU component
marks the new application as valid and performs a restart. If the application update is aborted for any reason (power
loss, for example), this causes the application area to contain an invalid image. The update process can be restarted
from the beginning in this case, as the device still contains a valid Bluetooth Low Energy stack with the DFU
component.
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3.4 APPLICATION + FOTA BLUETOOTH Low ENERGY STACK UPDATE

This type of update is performed in multiple steps:

1.
2.

6.

Start the DFU component.
When the FOTA process receives a Bluetooth Low Energy stack image instead of an application image, no

revision check is performed, and the downloaded image is saved in the application area. The FOTA process
executes code from the Bluetooth Low Energy stack area, so it is not possible to directly replace the Bluetooth
Low Energy stack.

After completely programming the new Bluetooth Low Energy stack image into the download/application area,
the DFU component performs a reset and thereby activates the bootloader.

The bootloader detects a valid Bluetooth Low Energy stack image in the download area and copies it to the
Bluetooth Low Energy stack area. This is now possible because the previous Bluetooth Low Energy stack is no
longer needed. After successfully copying the new Bluetooth Low Energy stack, the bootloader invalidates the
Bluetooth Low Energy stack in the download/application area and proceeds with the firmware startup.

As with a usual bootloader startup, the DFU component of the new Bluetooth Low Energy stack detects no
valid application, and therefore starts the FOTA DFU again to receive the new application image.

From this point on, the process is the same as it is with an application only upgrade.

Because the application area is used to temporarily hold the Bluetooth Low Energy stack image, the size of the
Bluetooth Low Energy stack cannot exceed half of the size of the area between the end of the bootloader area and the
end of the main flash area. This limits the Bluetooth Low Energy stack size to a maximum of (380-8)/2 = 186 KB.

If the bootloader copy operation of the Bluetooth Low Energy stack image from the application area to the
Bluetooth Low Energy stack area is aborted, at next startup the bootloader detects the still-valid Bluetooth Low Energy
stack image in the application area and repeats the copy. This makes it possible to recover from power loss during the
update process.
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CHAPTER 4

Performing Your First FOTA Update

4.1 OVERVIEW

Before we dive into all details regarding the FOTA tools, firmware images, and protocol specifications, this chapter
walks you step-by-step through the process of performing your first FOTA update. The goal is to provide you a basic
hands-on understanding of the RSL10 FOTA update process, and to ensure that your hardware and software are
correctly setup. This chapter shows how to:

1. Generate a FOTA firmware image using the preconfigured ble_peripheral server hrp fota sample application.
This application is similar to the Heart Rate Bluetooth Low Energy application (ble_peripheral server hrp)
with added features to support FOTA updates.

2. Set up the RSL10 bootloader and load a firmware image using UART.

3. Perform a FOTA update using the FOTA.Console PC tool. Alternatively, a FOTA update can be performed
using the mobile application. See Chapter 9 "RSL FOTA Mobile Application" on page 40.

This tutorial assumes that you have installed the prerequisites and have the required version of the RSL10 CMSIS-
Pack installed (see the RSL10 Getting Started Guide for instructions on how to import a CMSIS-Pack).

4.2 GENERATING THE FOTA FIRMWARE IMAGE

1. Open the Examples tab in the Pack Manager perspective to see example projects, included in the RSL10
CMSIS-Pack.
2. Find the ble_peripheral server hrp_fota example project and click the Copy button to import it into your
workspace. (See the figure "Importing the FOTA Sample Project" (Figure 3).)
@ Packs ™ Examples 2 Only show examples from installed packs | P e T Lf| @ ¥ T O
Search Example
Action

Example Description a

2 ADC_UART (RSL10 Evaluation Board) [ Copy
¥ Copy
2 ble_android_asha (RSL10 Evaluation Bi [# Copy
2 ble_central_client_bond (RSL10 Evalua [# Copy
£ ble_central_client_scan (RSL10 Evaluati [# Copy
< ble_central_peripheral (RSL10 Evaluati -2 Copy
% Copy
2 ble_peripheral_server_bond (RSL10 Ew: 2 Copy
< ble_peripheral_server_hrp (RSL10 Evall [# Copy
< ble_peripheral_server_hrp_fota (RSL10 £2 Copy
2 ble_peripheral_server_PRA (RSL10 Eval [& Copy
% Copy
S bootloader (RSL10 Evaluation Board) 2 Copy

2 aes128 (RSL10 Evaluation Board)

& ble_mesh (RSL10 Evaluation Board)

< blinky (RSL10 Evaluation Board)

& central_client_uart (RSL10 Evaluation B € Copw

ADC with UART Sample Code

AES128 - Simple AE5-128 Sample Code

Android Audio Streaming Hearing Aid Peripheral Sample Code
BLE Central Client Bonding Sample Code

Central Device with Client Scanner Sample Code

Central Peripheral Device Sample Code

Bluetooth Low Energy Mesh application

BLE Peripheral Server Bonding Sample Code

Heart Rate Peripheral Device with Server Sample Code
Heart Rate Peripheral Device with Server Fota Sample Code
Private resalvable Address with Server Sample Code

Blinky GPIO 1/0 Sample Code

Bootloader Sample Code

Central Device with Client UART Sample Code

Figure 3. Importing the FOTA Sample Project

3. The C/C++ perspective opens and displays your newly copied project. In the Project Explorer panel, you can
expand your project folder and explore the files inside your project, as seen in the figure "Files in FOTA Sample
Project" (Figure 4). On the right side, the ble_peripheral server hrp fota.rteconfig file displays the selected
software components, including the new component named Fota. If you expand RTE > Device > RSL10, you
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can find the FOTA library (libfota.a), the FOTA Bluetooth Low Energy Stack binary file (fota.bin), and the
Python tool mkfotaimg.py. These files are automatically added to your sample project once the Fota component
is selected.

File Edit Source Refactor Navigate Search Project Run Window Help
&][o][w] - || No Launch Configurations v |om |- vfid- | B v R G Oin| S @Sy GO v Qv Qv ™E 5~
MR (e Quick Access| | a9 | (G @
i¢5 Project Explorer & 5% % ¥ 7 O ¢ ble_peripheral_server_hp_fotarteconfig & =0 %o = . b =8
v & RsL10 ~ & Components .| @ v
[€ ble_bass.c [ ) e There is no active editor that provides an
[ ble_bassh [0 Software Components Sel. Variant Vendor Version  Description outline.
[ ble_dfusc B rsLio ONSemiconduc ARM Cortex-M3 48 MHz, 24 KB RAM, 388 KB ROM
@ ble_dfush v & CMSIS Driver
[& ble_diss.c vic O source ONSemiconduc 3.1.575  12C Driver for RSL10
[# ble_dissh | v sal O source ONSemiconduc 3.1575  SAl Driver for RSL10
[ ble_gape @ spl O source ONSemiconduc 3.1.575  SPI Driver for RSL10
[ ble_gaph ¥ USART O source ONSemiconduc 3.1.575  USART Driver for RSL10
[ ble_gattc v Device
[ ble_gatth ~ ¥ Bluetooth Core (API) 100 plementation
[@ ble_hrps.c ¥ BLE Abstraction B source ONSemiconduc 3.1.575 3
[B ble_hrpsh “: BLE Stack O release ‘GNSemwrcum!uc 31575 | Bluetooth S'afk libblelib)
[& ble_l2c.c [¢ Fota B release ONSemiconduc 3.1.575 |, Fota Library (libfota)
® ble_l2ch [ON ) ¥ Kernel O release  ONSemiconduc 3.1575  Event Kernel Library (libkelib)
[& msg_handler.c . ¥ Mesh O release ONSemiconduc 1.5.56 , Mesh Library
[8 msg_handler.n h Ellueto.oth Profiles
[& rsI10_protacol.c Libearies
[& rsl10_romvect.c [OF @ Startup B source ONSemiconduc 3.1.575 , System Startup for ON Semiconductor RSL10
[& rsl10_sys_asrc.c (O
(& rsI10_sys_audio.c
[%& rsl10_sys_clocks.c [(
I8t rsI10_sys_crc.c [OF < 5
(& 511055 dmac I Validation Output Description
I8k rs110_sys_flash.c [ON
& rs110_sys_power_modes.c [C
[& rs110_sys_power.c [ONS:
[& rsl10_sys_rffe.c [ONS
[& rsl10_sys_timers.c
I8 rsI10_sys_uart.c [ONSe
& rs110_sys_version.c 0
[8 RTE_Device.h [ ct Components Device Packs
sk sbricc [ONSem (2] Problems = Console w|e v =0
!‘* startc [0nsen 0 items
B startup 105 Description : Resource Path Location Type
|€ system_rsi10.c
[E fota.bin [OF ductor:De
lnt libbass.a [ON! e
i libdiss.a [ONS
[ libfotaa
It libhrps.a |
| mifotaimg.py [ON v
< >

Figure 4. Files in FOTA Sample Project

4. Build the ble peripheral server hrp_fota project. After a successful build, the ble_peripheral server hrp
fota.fota image is generated under the Debug folder, as seen in the figure ".fota Image in Debug Folder" (Figure
5):

www.onsemi.com
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W =

[ Project Explorer E3 =S B

= ble_peripheral_server_hrp_fota

g;-f Binaries
kit Includes

w = Debug

= RTE

[= source

app.c - [arm/1e]

f_& ble_peripheral_server_hrp_fota.elf - [arm/le]
=| app.d

ble_peripheral_server_hrp_fota.bin

ble_peripheral_server_hrp_fota.fota

ble_peripheral_server_hrp_fota.hex

ble_peripheral_server_hrp_fota.map
& makefile

& objects.mk

& sources.mk

subdir.mk

[= include

fit. RTE

[= source

le] app.c

4 ble_peripheral_server_hrp_fota.rteconfig

@ B @

readme_ble_peripheral_server_hrp_fota.md

Figure 5. .fota Image in Debug Folder

The generated .fota file contains both the Fota Bluetooth Low Energy stack sub-image (fota.bin) and the
application sub-image. This file can be used by the bootloader UART PC updater tool to perform a UART
firmware update, or by the FOTA.Console.exe PC tool to perform a FOTA update.

4.3 SETTING UP THE RSL10 BOOTLOADER AND LOADING A FIRMWARE IMAGE USING UART

1.

If you are running a FOTA update for the first time, your RSL10 EVB does not have the RSL10 bootloader
flashed into it.

Import and build the bootloader sample application, available in the Examples tab.

Start a debug session to flashload the bootloader application into the RSL10 Evaluation and Development Board
(or alternatively use the external flashloader to load the bootloader.hex file).

Reset your board. After reset, you can see that the LED of the RSL10 Evaluation and Development Board is
continuously on, indicating that bootloader has not found a valid user application or a valid FOTA Bluetooth
Low Energy stack, and therefore has activated its updater mode. In this mode, the bootloader is waiting for
commands over UART to download a new user application firmware image.

Use the Windows Device Manager to find out the COM port number assigned to your RSL10 EVB, identified
by the JLink CDC UART Port (COM4, as seen in the figure "RSL10 EVB COM Port Number" (Figure 6)):

www.onsemi.com
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v @ Ports (COM & LPT)
i JLink CDC UART Port (COM4)
i Silicon Labs CP210x USB to UART Bridge (COMS)

Figure 6. RSL10 EVB COM Port Number

6. Using a command prompt, navigate to the bootloader/scripts folder. You can see the updater.py tool together
with additional .d/l dependencies.

7. Invoke the updater.py tool to load the ble_peripheral server hrp fota.fota image over UART with the
following command:

> python updater.py COM4 ble peripheral server hrp fota.fota
Image : PSHRP ver=2.4.0 / FOTA ver=2.4.0
Bootloader : BOOTL* ver=2.0.1

Ahk Ak kA h kA kA hh Ak kA hk kA hk kA kA hhk ko hkhk Ak kA hk kA hkhk Ak hkhkhkhkhkhk kA hkhkhhkhkhhkhkhkhhkhhkhkhhkrhkkrhkkhkhhkrhkrhkhkxhkkxkkxk

You can expect similar output. For each flash sector transferred and written to the flash memory, an asterisk (*)
symbol is printed on the screen.

If you find errors executing this step, make sure you have the required versions of Python and the pyserial
package.

8. You can use the RSL10 Bluetooth Low Energy Explorer or another application to confirm that your new
firmware is running and advertising under the name Peripheral HRP FOTA, as shown in the figure "Firmware
Running" (Figure 7):

) BLE Explorer (COMS)
Setup ¢

Scan- Clear Sort Connect Disconnect JEyleyYle

Update Parameter Update Firmware

Peripheral HRP_FOTA .
EA-BBFF22-11-94 ‘ 49 o R Name Peripheral_HRP_FOTA
Fire e CorEs ae s Address EA:BB:FF:22:11:94 (Random Static)

Bonding -
N/A State Idle
76:36:3620:2238 M -96 RSSI 49
Bonded:No Connectable:No

Advertisement

N/A Flags 0x06 (LE General Discoverable Mode, BR/EDR Not Supported)
° ‘ : - % Apple. inc Complete Local Name Peripheral_HRP_FOTA
Bonded:No Connectable:Yes Service Data - 16-bit UUID 130D
N/A Manufacturer Specific Data Company ldentifier: onsemi (0x0362)
7iE592E10617 M -80 R Microsoft
Bonded:No Connectable:No

Figure 7. Firmware Running

Your device is now ready to perform a FOTA update, as it contains all the required components: the bootloader
program and the Fota Bluetooth Low Energy stack.

4.4 PERFORMING A FOTA UPDATE USING THE FOTA.CONsSOLE PC TooL

1. Make sure no other process is using the RSL10 Dongle (e.g.: close RSL10 Bluetooth Low Energy Explorer).

www.onsemi.com
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2. Use the Windows Device Manager to find the COM port number assigned to your RSL10 Dongle, identified by
the Silicon Labs USB to UART Bridge (COMS, in the example in the figure "RSL10 Dongle COM Port
Number" (Figure 8)):

v & Ports (COM & LPT)
i JLink CDC UART Port (COM4)
i Silicon Labs CP210x USE to UART Bridge (COM3)

Figure 8. RSL10 Dongle COM Port Number

3. The Fota.Console tool is available in the RSL10 Utility Apps zip package. Make sure to extract this package
and use a command prompt tool to navigate to the Fota. Console folder.
4. Run the Fota.Console.exe tool to start a FOTA update using the following command:

Fota.Console.exe /COM=COM5 /IN=ble peripheral server hrp fota.fota /NAME=Peripheral HRP
FOTA

Make sure to copy the .fota image file into the same folder as the Fota.Console tool, or specify the full path to
this file in the command above.

5. The Fota.Console tool searches, connects and transmits the firmware image to the RSL10 Evaluation and
Development Board. If everything goes as expected, you have successfully performed your first RSL10 FOTA
update. You can expect output similar to this:

Fota.Console.exe /COM=COM5 /IN=ble peripheral server hrp fota.fota /NAME=Peripheral HRP

FOTA
Fota.Console v1.0.5.0

Searching for peripheral

Found peripheral (Address:AA:BB:FF:22:11:94 RSSI:-57dBm Name:Peripheral HRP FOTA)
Connecting

———————————————————————— Peripheral HRP FOTA —--—---—--—————————————————

FOTA stack version: FOTA 2.4.0

Application version: PSHRP 2.4.0

Device ID: None

———————————————————————— ble peripheral server hrp fota.fota ---—-——------------—-————-
FOTA stack version: FOTA 2.4.0

Application version: PSHRP 2.4.0

Device ID: None

Service UUID: Db2152466-d600-11e8-9f8b-£f2801f1b9fdl

FOTA build ID: 04 00 00 00 14 00 00 00 03 00 00 00 47 4E 55 00 5F 20 56 EC 3E E6 11 BD 98
4E F2 5E 21 48 E7 97

Establish

RebootToBootloader

Establish

UpdateApplImage

<-- 100.0% 14.8kB/s UpdateAppImage

Finished
Completed with status Success

www.onsemi.com
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If you have trouble executing this step, make sure you have installed the required versions of the drivers and
.Net framework.
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CHAPTER 5

FOTA Image

5.1 OVERVIEW

The FOTA Image (.fota file) consists of two sub-images, with padding to a multiple of 2048 bytes in-between so
that the start of the second image lies on an RSL10 flash sector boundary. The first sub-image is the FOTA Bluetooth
Low Energy Stack (fota.bin) and the second one is the user application (app.bin). The Python utility mkfotaimg.py
generates the FOTA image, as illustrated below in the figure "Image Format" (Figure 9):

binary files app.fota
fota.bin fota.bin
mkfotaimg.py padding

app.bin app.bin

Figure 9. Image Format

The .fota file can then be used as input to the FOTA.Console.exe tool for a FOTA update, or as input to the
updater.py tool to perform a UART firmware update via the bootloader. For more information about the bootloader,
see the RSL10 Bootloader User's Guide.

5.2 MKFOTAIMG.PY

The mkfotaimg.py tool takes two positional arguments as inputs: the FOTA Bluetooth Low Energy stack sub-image
and the user application sub-image. Its usage and optional arguments are shown below.

Usage:

> mkfotaimg.py [-h] [--version] [-d UUID] [-s KEY-PEM] [-1 UUID][-n NAME] [-o OUT-IMG]
FOTA-IMG APP-IMG

Arguments are shown in the table "Positional Arguments" (Table 1) and the "Optional Arguments" on the next
page:

Table 1. Positional Arguments

Argument Meaning

FOTA-IMG FOTA stack sub-image containing the Bluetooth Low Energy
stack and the DFU component (.bin file)

APP-IMG application sub-image (.bin file)

www.onsemi.com
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Table 2. Optional Arguments

Argument Meaning

-h, --help show help message and exit

--version show program's version number and exit

-d UUID, --devid UUID device UUID to embed in the image (default: no ID)

-s KEY-PEM, --sign KEY-PEM name of signing key PEM file (default: no signing)

-i UUID, --srvid UUID advertised UUID to embed in the image (default: DFU service
uuID)

-n NAME, --name NAME advertised name to embed in the image (default: ON FOTA
RSL10)

-0 OUT-IMG name of output image file (default: <APP-IMG>.fota)

This Python utility can be integrated into the post-build steps of Eclipse to generate the .fota format file every time
a user application project is built. This configuration is available in Project > Properties > C/C++ Build > Settings >
Build Steps > Post-Build Steps. Two steps are required to generate the .fofa image. First, we need to generate the
app.bin, which is the application sub-image. This is done using the objcopy tool, as follows:

arm-none-eabi-objcopy -0 binary <app name>.elf <app name>.bin

Then, we can call the mkfotaimg.py utility to generate the final FOTA image (app.fota file) from the stack sub-
image (fota.bin) and the application sub-image (app.bin) generated above the .fota image, as follows:

mkfotaimg.py fota.bin <app name>.bin

In order to invoke both commands, the two can be combined with the “&&” operator. Chapter 8 "Integrating
FOTA Into Your Application" on page 29, walks you step-by-step through generically configuring this post-build step
for any application, including the path for the Python utility, FOTA stack binary file, and application binary file.

5.3 SuB-IMAGE FORMAT

A sub-image contains the 1-to-1 flash content for RSL.10. We use positions 7 and 8 of the vector table to store
pointers for the version info and the image descriptor, as shown in the figure "Vector Table Positions" (Figure 10):
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Vector O Initial Stack pointer
Vector 1 Reset handler
Vector 2-6 Exception handlers
Vector 7 Pointer to version info
Vector 8 Pointer to image descriptor

Figure 10. Vector Table Positions

Every vector is a 32-bit value. With the Reset handler vector, the image start address can be calculated as:
< image start address >=< reset handler vector > & ~ 0z7FF

To find the version info and image descriptor, we calculate the corresponding image offsets by subtracting the
image start address from the vector value:

< of fset version info > = < pointer toversion info > — < tmage start address >
< of fset image descriptor > = < pointer to image description > — < image start address >
All multi-byte values in the description are in little-endian format.

The version info has the following format:

typedef struct
{
char id[e6]; // ID string
uintl6_t num; //<major[15:12]>.<minor[11:8]>.<revision[7:0]>
} version;

typedef struct
{

version img ver // image version

uint8 t dev_id[16]; // device UUID set by mkfotaimg (default all Os)
} version info;

In the FOTA stack sub-image, the version info is directly followed by a configuration structure:

typedef struct
{
uint32 t length; // length of this structure in bytes
uint8 t pub key[64]; // public signing key set by mkfotaimg
// (default all Os)
uint8 t srv_id[16]; // service UUID used when advertising
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// set by mkfotaimg (defaults to the
// DFU service 1ID)
uintl6 t dev_name len; // device name length set by mkfotaimg
// (defaults to 13)
uint8 t dev name[29]; // device name used when advertising
// set by mkfotaimg (defaults to
// “ON FOTA RSL10”)
} config info;

The image descriptor has the following format:

typedef struct
{

uint32 t image size; // image size in bytes excluding the signature
uint32 t build id[8]; // FOTA stack build ID
} image descriptor;

The FOTA stack build IDs from the two sub-images must match; otherwise it means that the application image has
been linked against another version of the FOTA stack image as included in the FOTA image, in which case an IMAGE
DNL_BAD BUILDID error is generated. The public key derived from the signing key is stored in the configuration
structure of the FOTA stack sub-image (see above struct config info field pub_key). The image size found in the
image descriptor excludes the signature, so you must add 64 to the size to get the total sub-image size.

5.4 SIGNING THE FOTA IMAGE

The mkfotaimg.py tool provides an optional feature for signing the generated FOTA image with the -s or --sign
optional argument. It requires a PEM file that is used as the signing key. Both sub-images (Bluetooth Low Energy stack
and application) are appended by their 64-byte signatures before being concatenated into a single .fota file. These
signatures are SHA256 sub-image hashes, signed with the elliptic curve NIST256p derived from the provided signing
key. When the -s or --sign parameter is not used, the images are not signed, and a 64-byte dummy signature is
appended to the sub-images.

To generate a signing key, you can take advantage of the Python ecdsa package and save the generated key in a
PEM file, as shown below:

>>> import ecdsa
>>> sign key = ecdsa.keys.SigningKey.generate (curve=ecdsa.curves.NIST256p)
>>> with open('key.pem', 'wt') as file:

pem = sign key.to pem()

file.write (pem.decode())

You can also use other tools to generate your signing key, such as openss!:

> openssl ecparam -name prime256v1l -genkey -noout -out key.pem

IMPORTANT: The signing key is a secret. Keep it safe!

5.5 FOTA SIGNATURE VALIDATION

This section describes the validation of the FOTA image’s signature.
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IMPORTANT: If the validation of the signature is critical from a secure update standpoint, make sure that a
public key is used. If the signature validation code does not encounter a public key, the code goes on to check
for image corruption, rather than returning an error. This allows you to do without a public key for such
situations as initial testing, but it creates a potential security fault if a public key is not used in more serious
situations.

5.5.1 Performing Signature Validation

To perform FOTA signature validation, proceed as follows:

1. Create a signing key, as described above in Section 5.4 “Signing the FOTA Image” on page 19. This signing
key must be used for all FOTA image creations that apply to the same device.

2. Build your application, and call (normally implicit by post-build step) mkfotaimg.py with the parameter's
<signingkey> (see Section 5.2 “mkfotaimg.py” on page 16) to generate the initial FOTA image.

3. Program the bootloader to the RSL10 as shown in Section 4.3 “Setting Up the RSL10 Bootloader and Loading a
Firmware Image Using UART” on page 12.

4. Program the initial FOTA image into the device, via the bootloader, as shown in Section 4.3 “Setting Up the
RSL10 Bootloader and Loading a Firmware Image Using UART” on page 12.

5. Build the new release of the application.

6. Call mkfotaimg.py with the same signing key to generate the new FOTA image.

7. Download the new FOTA image to the device with Fota.Console.

This process guarantees that only FOTA images which are signed with the same key are accepted by the device.
The device can only check the image signature after the whole image has been transferred—and therefore, has already
overwritten the previous application. If the signature check fails, the device is without a valid application. You can still
download a valid FOTA image if one is available; without a valid FOTA image to download, the device is not operable.

Therefore, mkfotaimg. py provides the parameter -d (see Section 5.2 “mkfotaimg.py” on page 16). If you provide
this parameter with a device specific UUID (which you can generate yourself), this UUID becomes embedded in the
FOTA image, causing the device to accept only new FOTA images with the same UUID. The device can check this
UUID before the currently installed application is overwritten; and if there is a mismatch, the device still works.

The bootloader does no signature check; therefore, it is possible to install any FOTA image via the bootloader. An
update via FOTA is only possible if the signature of the new FOTA image corresponds with the signature key already
installed. If no signature key is installed on the device, any sub-image (signed or not) is accepted. If the transferred sub-
image is a signed FOTA stack sub-image, then only correctly signed sub-images will be accepted.

5.5.2 FOTA Image Checking with the DFU Component

When generating a FOTA image, mkfotaimg.py first embeds the information provided to it through parameters
(device UUID, advertising UUID, advertising name and public part of signing key) into the FOTA stack sub-image
(device UUID instruct version, advertising UUID, advertising name and public part of signing key instruct
config info) and into the application sub-image (only device UUID instruct version). (See Section 5.3 “Sub-Image
Format” on page 17.) Then mkfotaimg.py signs both the FOTA and application sub-images with the private part of
the signing key, appends the signatures to the corresponding sub-images, pads the FOTA stack sub-image to RSL10
flash sector (2KiB) alignment, concatenates the FOTA stack sub-image followed by the application sub-image, and
finally writes the result as a FOTA image to disk (see Section 5.1 “Overview” on page 16).
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The DFU client (Fota.Console) splits the FOTA image into the two sub-images again, and transfers first the FOTA
stack sub-image (only if needed) and then the application sub-image. The FOTA image can be split because both sub-
images contain data on their own lengths (see Section 5.3 “Sub-Image Format” on page 17). If the build ID of the new
FOTA image (see Section 5.3 “Sub-Image Format” on page 17, referring to struct image descriptor) is different
from the build ID of the installed FOTA image (which can be read out via the FOTA Stack Build ID characteristic,
shown in Section 6.5 “DFU Service Characteristics” on page 26), the DFU client has to send the FOTA stack sub-
image first.

The DFU component of the FOTA stack checks the embedded information in the already installed FOTA stack
sub-image version against a received sub-image (see code file fota/dfu/app _dfu.c function Checklmage), in this way:

1. Checks the start address of the sub-image; if the address is incorrect, the process aborts with error code IMAGE
DNL BAD_ START.

2. Checks the image length against available space in flash memorys; if the length is incorrect, the process aborts
with error code IMAGE DNL_BAD SIZE.

3. Checks the device UUID; if there is a UUID mismatch, the process aborts with error code IMAGE DNL BAD
DEVID.

4. For application sub-images only, checks build ID; if there is a build ID mismatch, the process aborts with error
code IMAGE DNL BAD BUILDID.

5. The verification steps 1 through 4 are performed as soon as the image header is received. If the verification is
successful, the DFU component continues to download the rest of the sub-image and starts overwriting the
application area in the flash memory.

6. Checks the received signature against the calculated image hash and the public part of the signing key; if the key
is incorrect, the process aborts with error code IMAGE DNL_BAD_ SIG and the downloaded image is not marked
as valid.

7. Restarts the device. (If the bootloader then detects a valid FOTA stack sub-image in the application area, it will
copy it to the FOTA stack area first before starting the DFU component from the newly installed FOTA stack
sub-image.)

5.5.3 More About Digital Signature Validation

The public part of the signing key is stored in the already installed FOTA stack sub-image in the struct config
info field pub_key (see Section 5.3 “Sub-Image Format” on page 17).

For the general workings of digital signatures, refer to:

https://en.wikipedia.org/wiki/Digital signature

For the specific algorithms used by FOTA, refer to:

https://en.wikipedia.org/wiki/Elliptic Curve Digital Signature Algorithm
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CHAPTER 6

The DFU

6.1 DFU COMPONENT

The Device Firmware Update (DFU) component, which is embedded in the FOTA stack, acts as the server for the
DFU service. This component performs the actual update via the DFU custom service. The DFU component is activated
automatically at device startup if no valid application sub-image is found on the device. The application can also start
the DFU component by calling the function Sys_Fota StartDfu().

IMPORTANT: Sometimes smartphones do not handle a service changed indication correctly. Therefore, in
the DFU initialization, the first two bits of the device’s Bluetooth address are set to 0 to force the smartphone
to perform a service discovery.

6.2 UPDATE SEQUENCE

The DFU client scans for a device advertising the configured service ID (normally the DFU service ID). When the
device is found, the DFU client connects to the device and reads its characteristics (Device ID, Versions, Build ID). The
client must only accept FOTA images with matching Device IDs, unless the Device ID characteristic is all Os, which
means the device is compatible with all FOTA images.

If the Build ID of the application sub-image differs from the Build ID characteristic, the client needs to download
the FOTA stack sub-image first. After this downloads successfully, the client needs to disconnect from the device,
which restarts the device with the new FOTA stack. Now the client needs to reconnect to the same device.

If the Build ID of the application sub-image matches the Build ID characteristic, the client needs to download the
Application sub-image. After successfully downloading, the client needs to disconnect from the device, which restarts
the device with the new user application.

6.3 FOTA STACK SOURCE CODE

The RSL10 CMSIS-Pack includes a prebuilt version of the FOTA Stack available in the form of a software
component, as shown in Chapter 4.1 "Overview" on page 10. The fota.bin and libfota.a files are located under <emsis_
pack_root>/ONSemiconductor/RSL10/<version>/lib/Release. The source code to generate these files is also
available in the CMSIS-Pack, under <emsis_pack__
root>/ONSemiconductor/RSL10/<version>/source/firmware/fota.

If you would like to customize and rebuild these files, follow these steps:

1. Import the source code project. Navigate to File > Import > General > Existing Projects into Workspace, set
the Select root directory: option with the path to the source code, mark the checkbox Copy projects into
workspace, and click Finish. The project appears in the left side of Project Explorer, as shown in the figure
"Copying the Project" (Figure 11).

www.onsemi.com

22



onsemi

RSL10 Firmware Over-The-Air User’s Guide

5 Project Explorer 3 = {“=r1=l} |

T -

|E|] Includes

= ble

= dfu

. RTE

= stack

L thirdparty
= tools

lh| config.h
|k sys_fota.h
2% app

£ fota.rteconfig

Figure 11. Copying the Project

2. Modify the source code. For example, change the FOTA stack version number in config.h.

#define VER MAJOR 2
#define VER_MINOR 5//4
#define VER REVISION 0

3. Build the project. After building successfully, /ibfota.a and fota.bin are generated under the Debug or Release
folder, as shown in the figure "Building the Project" (Figure 12).
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5§ Project Explorer &3 = {‘EL}
v == fota
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= dfu
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= ble
= dfu
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= thirdparty
f‘;« fota.elf - [arm/lg]
] libfota.a
=| fota.bin
=| fota.hex
=| fota.id
B fota.map
makefile
ohjects.mk
sources.mk

Figure 12. Building the Project

4,

5.

To use your customized files, replace the /ibfota.a and the fota.bin in your in your CMSIS-Pack installation
(<emsis_pack_root>/ONSemiconductor/RSL10/<version>/lib/Release).

After replacing these files, it is necessary to refresh the RTE folder of existing projects in your workspace, so
that the IDE uses the newly generated files. The simplest way to do this is to delete the fota.bin and libfota.a
files under RTE > Device > RSL10, and refresh your sample project (for example, you can do this in ble_
peripheral _server_hrp_fota).

Rebuild the ble_peripheral server hrp fota project so that a new .fota image is generated based on your
modified libfota.a and fota.bin files.

Run Fota.Console to perform a FOTA update. The tool detects the updated version number of the stack FOTA
stack version: FOTA <higher_ version_number>, in comparison to the one installed on the device. (In this
example, we are using FOTA stack version: FOTA 2.5.0, for when version 2.4.0 is installed.) This means a
full update is required (FOTA Stack + application). This is performed in two steps: first, the FOTA stack is
updated; next, the device resets and the user application is updated. Notice the UpdateFotaImage and
UpdateAppImage logs below.
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> Fota.Console.exe /COM=COM5 /IN=ble peripheral server hrp fota.fota /NAME=Peripheral

HRP FOTA

Fota.Console v1.0.5.0

Searching for peripheral

Found peripheral (Address:AA:BB:FF:22:11:94 RSSI:-43dBm Name:Peripheral HRP FOTA)
Connecting

———————————————————————— Peripheral HRP FOTA —--—---—--—————————————————

FOTA stack version: FOTA 2.4.0

Application version: PSHRP 2.4.0

Device ID: None

———————————————————————— ble peripheral server hrp fota.fota ---——------------—-————-
FOTA stack version: FOTA 2.5.0

Application version: PSHRP 2.4.0

Device ID: None

Service UUID: Db2152466-d600-11e8-9f8b-£f2801f1b9fdl

FOTA build ID: 04 00 00 00 10 00 00 OO 03 00 00 00 47 4E 55 00 23 F3 2C 65 FD E3 13 BO EC
97 F5 8F 1F EO E1 47

Establish
RebootToBootloader
Establish

UpdateFotalmage
<-- 100.0% 15.0kB/s UpdateFotalImage
Establish

UpdateApplImage
<-- 100.0% 6.3kB/s UpdateAppImage

Finished
Completed with status Success

6.4 DFU BLUETOOTH Low ENERGY SERVICE

On the RSL10 device the DFU service is used as the server; the DFU service client runs on the PC (the
FOTA.Console tool). (See the table "DFU Service UUID" (Table 3).)

Table 3. DFU Service UUID

Requirement uuiD

Mandatory for DFU component, optional for device application b2152466-d600-11e8-9f8b-f2801f1b9fd 1

If the device application does not implement this service, another method must be used to activate the DFU mode
in the device (e.g. push button).
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Table 4. DFU Service Characteristics and their Properties

Characteristic uuibD Properties Length Description Requirements
Transport b2152466-d601- Notify, Write | variable Internally used characteristic to Mandatory for DFU
11e8-9f8b- without (max. transport data with the DFU component, prohibited
f2801f1b9fd1 response 512) protocol. for device application.
Device ID b2152466-d602- Read 16 Device ID as found in the version Mandatory for DFU
11e8-9f8b- info of the FOTA stack sub-image. | component, optional for
f2801f1b9fd1 Only FOTA images with the same device application.
device ID are compatible, unless
this characteristic is all Os, in which
case all FOTA images are
compatible.
BootLoader b2152466-d603- Read 8 Version of the installed Mandatory for DFU
Version 11e8-9f8b- (Format BootlLoader. component, optional for
f2801f1b9fd1 struct device application.
version)
FOTA Stack b2152466-d604- Read 8 Version of the installed FOTA stack | Mandatory for DFU
Version 11e8-9f8b- (Format sub-image (of type struct version). | component, optional for
f2801f1b9fd1 struct device application
version)
Application b2152466-d605- Read 8 Version of the installed application | Mandatory for DFU
Version 11e8-9f8b- (Format sub-image. If no valid application component, optional for
f2801f1b9fd1 struct sub-image is currently installed, device application.
version) then all Os is returned.
FOTA Stack b2152466-d606- Read 32 Build ID as found in the descriptor Mandatory for DFU
Build ID 11e8-9f8b- of the FOTA stack sub-image. If the | component, optional for
f2801f1b9fd1 Build ID of the FOTA image to device application
download is different from the one
in this characteristic, then both sub-
images must be updated;
otherwise, updating only the
application sub-image is sufficient.
Enter DFU b2152466-d607- Write 1 A write with the value 1 switches Prohibited for DFU
11e8-9f8b- from the Application mode to the component, mandatory
f2801f1b9fd1 DFU mode. for device application.

6.6 DFU ProTOCOL

The application layer uses a Command/Response scheme. Every Command/Response consists of a standard header
and an optional body. The header has the following format:

{

} header;

uint8 t
uint8 t param[3];
uint32 t body len;

typedef struct

code;

// unique Command/Response code
// Command/Response specific parameters
// length of the following body (0 = no body)

www.onsemi.com

26




onsemi

RSL10 Firmware Over-The-Air User’s Guide

Currently only a single Command/Response is specified: IMAGE DOWNLOAD (code = 1). The command is used
to transfer a sub-image to the RSL10 device. The three parameters are not used by the command and must be set to 0.
The body contains one of the two sub-images including the signature. The response signals back the success or failure
of the operation; in the case of failure, the device can send the response before the whole command body is transferred.

The response itself has no body. Param[0] is used for the status; the other parameters are not used, and must be set to
0.

The table "Status Codes" (Table 5) shows the specific status codes:

Table 5. Status Codes

Code Meaning

0 The sub-image has been downloaded successfully

1 Download rejected due to incompatible Device ID

2 Download rejected due to incompatible Build ID (only for application sub-images)
3 Download rejected due to image size too large or small

4 Download failed due to flash storage error

5 Download failed due to invalid signature

6 Download rejected due to invalid start address

For the transport layer, an HDLC-like protocol with windowing is used to transport the upper layer SDUs. For the
data-link layer, the transport characteristic of the DFU service is used.
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CHAPTER 7

The Fota.Console Command Line Tool

7.1 FOTA.CONSOLE

Fota.Console is a simple PC command line tool for downloading firmware images using Bluetooth Low Energy
technology. An RSL10 USB dongle on the PC side is required to establish a Bluetooth Low Energy connection.

Usage:

> Fota.Console.exe /COM=COMx /IN=<APP-IMG>.fota [/NAME=<device name>]
[/ADDR=<aa:bb:cc:dd:ee:ff>]

Parameters are shown in the table "Parameters" (Table 6):

Table 6. Parameters

Parameter Meaning

/COM COM port connected to RSL10 Dongle (e.g. COM1)

/IN Path to a .fota file that is sent over a Bluetooth Low Energy connection.

/INAME Optional advertising name of the peripheral device

/ADDR Optional Bluetooth Low Energy address of the peripheral to connect. e.g.
60:C0:BF:00:14:62
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CHAPTER 8

Integrating FOTA Into Your Application

This chapter shows how to modify an existing sample application to make it capable of receiving FOTA updates.
We start with the ble_peripheral _server bond application and walk you, step-by-step, through all the required project
configurations and firmware changes. Then, we show how to perform a FOTA update to confirm that the integration
has been executed successfully.

8.1 MODIFYING THE APPLICATION

1. Copy the ble_peripheral server bond sample application into your workspace. The C/C++ perspective opens
and displays your newly copied project, as shown below in the figure "Bringing the Project Into the Workspace"
(Figure 13).

@ Packs % Examples 2 Only show examples from installed packs | oF M 5 Py Lf| @ ¥ = 0
Search Example
Example Action

& ADC_UART (RSL10 Evaluation Board) I.Q Copy

Description a
| ADC with UART Sample Code

S aes128 (RSL10 Evaluation Board)
< ble_android_asha (RSL10 Evaluation Bll_’ Copy

£ ble_central_client_bond (RSL10 Evalua I_Q Copy
& ble_central_client_scan (RSL10 Evaluati I_Q Copy
£ ble_central_peripheral (RSL10 Evaluati I.Q Copy
< ble_peripheral_server_bond (RSL10 Ev: I_Q Copy
& ble_peripheral_server_hrp (RSL10 EvaILI.’ Copy
£ ble_peripheral_server_hrp_fota (RSL10 I_Q Copy
& ble_peripheral_server_ PRA (RSL10 Evall_’ Copy
% Copy
2 hnntloader (RSI 10 Fualiatinon Roardd |..(“T

£ blinky (RSL10 Evaluation Board)

Figure 13. Bringing the Project Into the Workspace

I_Q Copy

AES128 - Simple AES-128 Sample Code

| Android Audio Streaming Hearing Aid Peripheral Sample Code
| BLE Central Client Bonding Sample Code

| Central Device with Client Scanner Sample Code

| Central Peripheral Device Sample Code

| BLE Peripheral Server Bonding Sample Code

| Heart Rate Peripheral Device with Server Sample Code

| Heart Rate Peripheral Device with Server Fota Sample Code

| Private resolvable Address with Server Sample Code

| Blinky GPIO 1/0 Sample Code

Rontlnader Samnle Cnde

2. Add the FOTA software component to your project by using the RTE Configuration Wizard (the ble
peripheral_server _bond.rteconfig file). When you select the Fota component and click save, libfota.a, fota.bin
and the tool mkfotaimg.py are copied into your project, under RTE > Device > RSL10. In addition, you need to
deselect the BLE Stack and Kernel components and click to save, as shown in the figure "Adding the FOTA

Software Component" (Figure 14).
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E"g] r=10_sys_version.c [OMSemiconductor:Device,Lil
[n] RTE_Device.h [ONSemiconductor:Device.Startup
[} sbrk.c [ONSemiconductor:Device.Startup.source
[} start.c [OMSemiconducter:Device.Startup.source
[8) startup_rsl0.5 [ONSemiconductor:Device Startu)
[ system_rsl10.c [OMSemiconductor:Device.Startu
\Z| fota.bin [OMSemiconductor:Device.Bluetooth Ce
libbass.a [OMSemiconductor:Device.Bluetooth P
libfota.a [OMSemiconductor:Device Bluetooth C
[# mlkfotaimg.py [ONSemiconductor:Device Blueto
| sections.ld [ONSemiconductor:Device.5tartup.so
» E"g] stubprf.c [:Device.Bluetooth Core]

>
>
>
b4
>
*>
>
>
>
b4
>
>
>
>
» @ r5l10_sys_audio.c [OMSemiconductor:Device.Libr
>
>
>
>
>
>
>
>
>
>
>
>
>
>
>

OgcOR

&l

source
release
release
release
release

source
FreeRTOS

» [h RTE_Compenents.h
» = source
> [€ appc
4 ble_peripheral_server_bond.rteconfig

Validation Output

@ readme_ble_peripheral_server_bond.md

Figure 14. Adding the FOTA Software Component
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3. Modify the source code to set the FOTA version number and ID:
a. In app.h, define your version numbers and ID:

/* ,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

* Application Version

#define VER_ID "PSBOND"
#define VER MAJOR 2
#define VER MINOR 4
#define VER REVISION 0

b. Inapp.c, include sys_fota.h and use the SYS FOTA VERSION macro to set the version:

#include "sys fota.h"

/* ____________________________________________________________________________

* Application Version

SYS FOTA VERSION(VER ID, VER MAJOR, VER MINOR, VER REVISION) ;

4. Modify the sample application to activate the DFU when the button (DIOS) on the RSL10 EVB is pressed.
a. In app.h, define DIOS as BUTTON_DIO, this way:

#define BUTTON DIO 5

b. Inapp config.c, modify the Device Initialize () function to configure DIOS as a GPIO input:

void Device Initialize (void)

{

/* Configure the push button of the RSL10 EVB as GPIO input */
Sys DIO Config (BUTTON DIO, DIO MODE GPIO IN O | DIO WEAK PULL UP | DIO LPF DISABLE);

}

c. Inapp.c, add the code below in the while (1) loop of the main () function, to start the DFU when the
button is pressed:

while (1)

/* Start Update when button is pressed */
if (DIO_DATA->ALIAS[BUTTON DIO] == 0)
{
Sys Fota StartDfu(l);
}
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The DFU component is activated by calling the Sys Fota StartDfu(mode) function defined in sys_
fota.h. The mode value 0 is for an application without the Bluetooth Low Energy stack (for example,
blinky), and 1 is for an application that uses the Bluetooth Low Energy stack (such as ble_peripheral
server_bond).

5. Change the device name for testing:

/* Advertising data is composed by device name and company id */
//#define APP DEVICE NAME "ble periph server bond"
#define APP DEVICE NAME "Peripheral BOND FOTA"

6. Replace your sections.ld file with the one that contains the FOTA placement, and also replace your startup
rsl10 file, as shown in the figure "Replacing the sections.ld and startup_rsl10.S Files" (Figure 15). The new
sections.ld file and startup rsl10 file can be copied from ble peripheral server hrp_ fota, or directly from the
CMSIS-Pack root folder as follows:

° sections.ld: <CMSIS Pack root folder>> onsemi> RSL10 > <version> > source > firmware >
fota > app

o startup rsl10: <CMSIS Pack root folder> >onsemi > RSL10 > <version> > source > firmware
> fota > RTE > Device > RSL10

NOTE: For FOTA and sleep-based applications, use the sections.ld from the following location:

<CMSIS_Pack_root_folder>lonsemi\RSL10\<version>\source\firmware\fota\app\sleep
fota\sections.ld
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[’9"*_1 Project Explorer 73 |
(V= ble_peripheral_server_bond

¥ @] Includes

w = include

> [b| app_bass.h

5 [n app_customss.h

> [n app_traceh

> [n app.h
~ fit. RTE

w = Device

w = R5L10
> @ ble_bass.c [OMNSemiconductor:Device.Bluetooth Core.BLE Abs

|E| ble_bass.h [ONSemiconductor:Device Bluetooth Core.BLE Abs
|§| ble_dfus.c [ONSemiconducton:Device.Bluetooth Core.BLE Abs
[n] ble_dfus.h [ONSemiconductor:Device Bluetooth Core.BLE Abs
[ ble_gap.c [OMSemiconductor:Device Blustooth Core BLE Abst
[n] ble_gap.h [ONSemiconductor:Device.Bluetooth Core.BLE Abs
[ ble_gatt.c [ONSemiconductor:Device.Bluetooth Core BLE Abs
[n] ble_gatt.h [ONSemiconductor:Device.Bluetooth Core.BLE Abs
|E| ble_I2c.c [OMSemiconductor:Device. Bluetooth Core.BLE Abstr
@ ble_l2c.h [OMSemiconductor:Device.Bluetooth Core.BLE Abst
[£ msg_handler.c [ONSemiconductor:Device Bluetooth CoreBLE
[n msg_handler.h [OMSemiconductor:Device.Bluetooth Core,BLE
@ rsl10_romvect.c [ONSemiconductor:Device Libraries. System.s:
E‘}, rsl10_sys_asrc.c [ONSemiconductor:DeviceLibraries, System.sc
@ rs110_sys_audio.c [OMSemiconductor:Device.Libraries, System.
@ rsl10_sys_clocks.c [OMSemiconductor:Device Libraries. System
@ rsl10_sys_cre.c [OMSemiconductor:Device.Libraries. Systern.son
@ rsl10_sys_dma.c [ONSemiconductor:Device Libraries. Systermn.s
@ rsl10_sys_flash.c [OMSemiconductor:Device.Libraries System.s
@ rsl10_sys_power_modes.c [ONSemiconductor:DeviceLibraries
[} rsI10_sys_power.c [ONSemiconductor:Device.Libraries.System
@ rsl10_sys_rffe.c [ONSemiconductor:Device Libraries. System.so
E‘}, rsl10_sys_timers.c [OMSemiconductor:Device Libraries, System
@ rsi10_sys_uart.c [OMSemiconductor:DeviceLibraries. Systemn.sc
E‘}, rsl10_sys_version.c [OMSemiconductor:Device Libraries. Systen
@ RTE_Device.h [OMSemiconductor:Device.Startup.source]
@ sbrk.c [OMSemiconductor:Device. Startup.source]

start.c [OMNSemiconducton:Device. Startup.source]

R L

» [€] system_rsi10.c [OMSemiconductor:Device.Startup source] NSemiconductor > R5L10 > <version> > source >

» startup_rsl10.5 [OMSemiconductor:Device.Startup. source] Location: <CMSIS Pack root folder> =
irmware > fota > RTE > Device > RSL10

[Z] fota.bin [OMSemiconductor:Device.Bluetooth Core.Fota.relea

libbass.a [OMNSemiconductor:Device.Bluetooth Profiles.BASS.r
libfota.a [ONSemiconductor:Device.Bluetooth Core.Fota.relea
™ mkfotaimg.py [OMSemiconductor:Device.Bluetooth Core.Foti
& rsl10_protocol.c

=| sections.ld [DNSemiconductor::Deuice.Startup.source]l_ Location: <CMSIS Pack root folder= >
@ stubprf.c [:Device.Bluetooth Core] QNSemlccnductorb RSL10 > <version=> > source >
AT firmware > fota > app

>
» [hl

E_Components.h

Figure 15. Replacing the sections.ld and startup_rsl10.S Files
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7. Modify the project post-build steps (see the figure "Post-Build Steps" (Figure 16)) to generate the FOTA image
in both Debug and Release build configurations, by going to Project > Properties > C/C++ Build > Settings >
Build Steps > Post-build steps. Two steps are required to generate the .fofa image. First, we need to generate
the application sub-image .bin file using objcopy. Then, we use the mkfotaimg.py tool to generate the FOTA
image (.fota file). Both commands can be concatenated with "&&" and added to the post-build steps as in the
example that follows. To use this command, copy the code from the Post-Build steps of the existing sample
application ble_peripheral server hrp fota., as the code in the text below is not directly copyable.

${cross_prefix}objcopy -0 binary "${BuildArtifactFileName}"
"${BuildArtifactFileBaseName}.bin" && "${ProjDirPath}/RTE/Device/RSL10/mkfotaimg.py" -o
"${BuildArtifactFileBaseName}.fota" "${ProjDirPath}/RTE/Device/RSL10/fota.bin"
"$S{BuildArtifactFileBaseName} .bin"

Settings MR

Configuration:  Debug [ Active ] | | Manage Configurations.

) Tool Settings 3 Toolchains J Devices [ Container Settings Build Steps Build Artifact Binary Parsers @3 Error Parsers

Comman: d:
[ stcrass_prefixtobjcopy -0 binary " p Lbin" &8 "S{ProjDirPath}/RTE/Device/RSL ot }fota” *S{ProjDirPath}/RTE/Device/RSL10/fota bin” "S{BuildAtifactFileBaseName} bin” |

Description:

Figure 16. Post-Build Steps

8. Build the ble_peripheral server bond application. If no error occurs, the FOTA image (ble peripheral server
bond.fota file) can be found in the Debug or Release folder.

8.2 PERFORMING A FOTA UPDATE

1. Make sure you have bootloader running on your RSL10 EVB. If you have executed the steps in Chapter 4.1
"Overview" on page 10, you already have bootloader flashed on your board and you can skip this step.
Otherwise, refer to Section 4.3 “Setting Up the RSL10 Bootloader and Loading a Firmware Image Using
UART” on page 12 for instructions.

2. Activate the bootloader updater mode: press both the reset and the user (DIOS) push buttons on the RSL10 EVB
simultaneously, and then release the reset button first. Upon releasing both push buttons, the LED (DIO6) on the
RSL10 EVB is set constant high, indicating that the bootloader updater is active, waiting for a firmware image
over UART.

NOTE: If there is a valid user application in flash (for example, the ble peripheral server hrp fota) and

no command is received over UART after a few seconds, the bootloader updater times out and
reboots into the user application.

NOTE: DIOS is configured as an input to RSL10. In RSL10 EVBs, DIOS is connected to both the push-
button SW1 and the Atmel ATSAM3U2CA-AU chip (which enables USB-to-JTAG). Care must
be taken to ensure that the Atmel chip is always powered in any power supply configuration. If
the Atmel chip is not powered, it can unexpectedly pull DIOS low, and the firmware code can be
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hung up in a while loop. Alternative procedures are to remove resistor R31 so that DIOS is not
connected to the Atmel chip, or to use a different DIO to initiate the FOTA process (this requires
changes to the sample code).

3. Load the ble_peripheral server bond. fota image using the bootloader with the following command:

> python updater.py COM4 ble peripheral server bond.fota
Image PSBOND ver=2.4.0 / FOTA ver=2.4.0
Bootloader BOOTLD ver=2.0.1

R R I I b I b I S S b S b S Sh e S b b Sh S Sh I Sb 2b b b S b I S b S b S b S Sb S b b S S Sb S b b Sh b S b i Sb b S Sh e S b S Sb e Ih b b 2 b S Sb b S 4
After loading the image, the bootloader resets the device and boots up the user application.

4. Verify that your application is running by looking for the advertisement name Peripheral BOND_FOTA on
the RSL10 Bluetooth Low Energy Explorer, as in the figure "Application Running" (Figure 17):

©) BLE Explorer (COM3)
Setup 7

Update Parameter Update Firmware

Connect  Disconnect Di

Peripheral & N Peripheral BOND_FOTA
D5BEFE221194 M -57 & onsemi ame eripheral_ - _
Bonded-No Connectable-Yes Address D5:BB:FF:22:11:94 (Random Static)
Bonding -
LE-Avi State Idle
SCATATOE0773 M -44 RSSI 57
Bonded:No Connectable:Yes
Advertisement
N/A Flags 0x06 (LE General Discoverable Mode, BR/EDR Not Supported)
76ACTBSE0DED 93 %} Apple, Inc Complete Local Name Peripheral_BOND_FOTA
Bonded:No Connectable:Yes . . .
Manufacturer Specific Data Company |dentifier: onsemi (0x0362)
N/A Manufacturer Specific Data Company |dentifier: onsemi (0x0362)
6F8030ABATDS M -94 R Apple Inc
Bonded:No Connectable:Yes

Figure 17. Application Running

5. Push the DIOS button on your RSL10 EVB so that the device starts the FOTA DFU mode. You can see the
name ON FOTA RSL10 on the RSL10 Bluetooth Low Energy Explorer, as in the figure "FOTA DFU Mode

Running" (Figure 18):
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©) BLE Explorer (COM3)
Setup 7

nnect Di

Update Firmware

N/A

AABCTACOTD B4 Name ON FOTA RSL10

Bonded-No Connectable. Address 33:7E:18:D4:AD:E1 (Randam Non Resolvable)
Bonding -

N/A State Idle

ZE93F453:557A ‘ -97 * Microsoft RSS! 50

Bonded:No Connectable:No .
Advertisement

ON FOTA RSL10 Flags 0x06 (LE General Discoverable Mode, BR/EDR Not Supported)
337E18D4ADE] M -50 T Power Level 0x00

Bl Crnrsa e Incomplete List of 128-bit Service Class UUIDs B2152466D60011E89F8BF2801F1B9FD

N/A Complete Local Name OMN FOTA RSL10

786EEDCB6C53 M 94 R Microsoft
Bonded-No Connectable:No

Figure 18. FOTA DFU Mode Running
Note: after 30 seconds, the FOTA DFU Mode times out and reboots into the user application.

6. Within 30 seconds of activating the FOTA DFU Mode, use the FOTA.Console PC application to update the
firmware as follows:

Fota.Console.exe /COM=COM5 /IN=ble peripheral server bond.fota
Fota.Console v1.0.5.0

Searching for peripheral

Found peripheral (Address:20:C0:BF:03:05:9B RSSI:-43dBm Name:ON FOTA RSL10)
Connecting

———————————————————————— ON FOTA RSL10 —-——=—=====———————————————

Bootloader version: BOOTLD 2.0.1

FOTA stack version: FOTA 2.4.0

Application version: PSBOND 2.4.0

Device ID: None

———————————————————————— ble peripheral server bond.fota ---------------————————-—
FOTA stack version: FOTA 2.4.0

Application version: PSBOND 2.4.0

Device ID: None

Service UUID: Db2152466-d600-11e8-9f8b-£f2801f1b9fdl

FOTA build ID: 04 00 00 00 14 00 00 00 03 00 00 00 47 4E 55 00 5F 20 56 EC 3E E6 11 BD 98
4E F2 5E 21 48 E7 97

Establish

UpdateApplImage
<-- 100.0% 4.4kB/s UpdateAppImage
Finished

Completed with status Success

7. You can repeat these steps to update the firmware with the ble peripheral server hrp.fota image as well. The
steps described here can be applied to any RSL10 sample application.

8. You might have noticed that in this part of the tutorial we need to press the DIOS push button to activate the
FOTA DFU mode. On the other hand, in Chapter 4.1 "Overview" on page 10, we use the Fota.Console tool to
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activate the DFU mode. The push button is required here, because we have not added the DFU Bluetooth Low
Energy custom service yet, and in particular, the characteristic Enter DFU (see Section 6.5 “DFU Service
Characteristics” on page 26 for details).
NOTE: DIOS is configured as an input to RSL10. In RSL10 EVBs, DIOS is connected to both the push-
button SW1 and the Atmel ATSAM3U2CA-AU chip (which enables USB-to-JTAG). Care must
be taken to ensure that the Atmel chip is always powered in any power supply configuration. If
the Atmel chip is not powered, it can unexpectedly pull DIOS5 low, and the firmware code can be
hung up in a while loop. Alternative procedures are to remove resistor R31 so that DIOS is not
connected to the Atmel chip, or to use a different DIO to initiate the FOTA process (this requires
changes to the sample code).
9. Modify app.c to include ble_dfiss.h and call DFUS Initialize () inthe main () function:

#include <ble dfus.h>

int main(void)

{

DFUS Initialize(); /* Initialize DFU Service Server */

10. Comment the call to GATTM AddAttributeDatabase () inthe APP GAPM GATTM Handler () function in
app_msg_handler.c, so that the component from the application is not added. The DFU component in FOTA
already calls GATTM AddAttributeDatabase () to add the characteristics for FOTA, so two separate calls to
set the attribute database would make the application confused. If you wish to include both components, you
need to merge their description in a single array.

void APP_GAPM GATTM Handler (ke msg id t const msg id, void const *param,
ke task id t const dest id,
ke task id t const src id)

{

switch(msg id)

{
case GAPM CMP EVT:
{

else if (p->operation == GAPM SET DEV CONFIG && p->status == GAP_ERR NO_ ERROR)
{

//GATTM AddAttributeDatabase (att db, CS NB); /* Add all custom services/

attributes */

}

11. Farther along in the APP_GAPM GATTM Handler () function, also comment the two lines that set up the
condition for all expected profiles/services to be added before starting to advertise, as shown in the following
code example:
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case GATTM ADD SVC RSP:
case GAPM PROFILE ADDED IND:

{
if(msg_id == GATTM ADD SVC_RSP)
{
PRINTF("\D\I_CUSTOM SERVICE ADDED");
}
else
{
PRINTF ("\n\r GAPM PROFILE ADDED IND");
}
/* If all expected profiles/services have been added */
//1f (GAPM GetProfileAddedCount () == APP NUM STD PRF &&
// GATTM GetServiceAddedCount () == APP_NUM CUSTOM SVC)
{

PRINTF ("\n\r START ADVERTISING");

GAPM StartAdvertiseCmd (&advertiseCmd); /* Start advertising */

12. Build the application and load it into your RSL10 EVB, using FOTA or the bootloader as shown in the previous

steps.

13. Connect and discover services using the RSL10 Bluetooth Low Energy Explorer, and you can see that the DFU
service is added in the attribute database, as shown in the figure "DFU Service in Attribute Database" (Figure

19):

© BLE Explorer (COM9)

D\s(onnec‘ Discover Services  Update Parameter Update Firmware
Info
(®) Generic Access (1800)

Peripheral BOND_FOTA Read
N/A

49:C98D:344C98 M -2 X Apple Inc.
Bonded:No ConnectableYes

0x0000 Read

UTFB String

Binary

(®) Generic Attribute (1801)

N/A
OFOF0984DB:02 M -94 B Microsoft
Bonded!No Connectable:No

N/A

0x0100FFFF Read [ Indication

Binary

6D:B;

~ X Apple. Inc. %BZWSMS&DGOOVHEB'QFSB'r 01F1B9FD1
Bonded:! 3
0x00000000000000000000000000000000 Read
LE-Avi

2CHIAIEDTT M58
Bonded:No Connectable:Yes
FOTA § Read
N/A

2051
Bon

Binary

UTF8 String

PSBONDS Read
N/A

B2227A8F 941D M -87 ¥ Hewlen-Packard Cor
Bonded:No Connectable:Yes

Write Req

I (®) Battery Senvice (180F)

26AFLI75E7T3 M -96 B Microsoft
BondedtNo ConnectableNo

N/A
584202163603 M -94 3 Apple Inc

Figure 19. DFU Service in Attribute Database

0x64 Read (V] Notification

UTF8 String

Binary

Binary
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14. The last characteristic shown (the one with the input text box) is the Enter DFU characteristic. If you write 01
into it, it enters the DFU mode and starts advertising under the name ON FOTA RSL10. This is what the
Fota.Console application does prior to transmitting the image file.

15. Now that you have confirmed that your DFU service is up and running, you can use the Fota.Console tool with
the attribute /NAME=Peripheral BOND_ FOTA to perform a FOTA update without the need to manually enter
the DFU mode through the push button.

Fota.Console.exe /COM=COM5 /IN=ble peripheral server bond.fota /NAME=Peripheral BOND FOTA
Fota.Console v1.0.5.0

Searching for peripheral

Found peripheral (Address:D5:BB:FF:22:11:94 RSSI:-48dBm Name:Peripheral BOND FOTA)
Connecting

———————————————————————— Peripheral BOND FOTA ----—--—-———————————————-

FOTA stack version: FOTA 2.4.0

Application version: PSBOND 2.4.0

Device ID: None

———————————————————————— ble peripheral server bond.fota -----------------—--—-—-
FOTA stack version: FOTA 2.4.0

Application version: PSBOND 2.4.0

Device ID: None

Service UUID: Db2152466-d600-11e8-9£f8b-£f2801f1b9fdl

FOTA build ID: 04 00 00 00 14 00 00 00 03 00 00 00 47 4E 55 00 88 5D D8 D8 CB 65 FO 94 C8
BE D6 07 99 2F D8 72

Establish
RebootToBootloader
Establish
UpdateAppImage

<-- 100.0% 7.7kB/s UpdateAppImage
Finished

Completed with status Success
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CHAPTER 9

RSL FOTA Mobile Application

RSL FOTA is a simple mobile application for iOS® and Android®, created to demonstrate Firmware-Over-The-Air
(FOTA) for onsemi RSL Bluetooth Low Energy devices. The RSL FOTA application acts as a central device to scan,

connect and transmit the firmware image to a remote RSL device. The remote RSL device firmware must have FOTA-
enabled firmware to receive the FOTA firmware image.

9.1 RSL FOTA APPLICATION

Follow these steps to use the RSL FOTA Mobile Application:

1. Download and install the RSL FOTA application from the Google Play Store or the Apple App Store.
2. Launch the application and select the FOTA enabled firmware device from the list of devices, as shown in the
figure "RSL FOTA Mobile Application Showing Bluetooth Low Energy Devices" (Figure 20).
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11:00

Devices

Peripheral_HRP_FOTA
EA:BB:FF:22:11:94

blinky_FOTA
D5:BB:FF:22:11:94

Figure 20. RSL FOTA Mobile Application Showing Bluetooth Low Energy Devices

3. When the appropriate device is selected, select the firmware image by clicking the Select File button.
4. Once the FOTA firmware image file is selected, click the Update button (see the figure "RSL FOTA Mobile

Application: Updating Firmware" (Figure 21)).
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11:00 QLUELN
< Update Firmware

DEVICE INFO

Name Peripheral _HRP_FOTA
Address EA:BB:FF:22:11:94
State Ready

Bootloader BOOTL* 1.0.0

Fota FOTA 2.4.1

App PSHRP 2.4.1

DISCONNECT

FIRMWARE INFO

Name ble_peripheral_server_hrp_fota.fota
Fota FOTA2.4.1

App  PSHRP 2.4.1

UpdateApplmage - 12.97kB/s

G)ATE

Figure 21. RSL FOTA Mobile Application: Updating Firmware
5. Upon firmware update completion, Update finished with code: 0 (Success) is displayed.

9.2 RSL FOTA ANDROID LIMITATIONS

Note the following important details when using the RSL FOTA Mobile Application:
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¢ Device location permission is needed to scan for Bluetooth Low Energy devices. If the permission is not granted
at app startup, the app is prevented from finding any Bluetooth Low Energy devices.

* Device storage permission is needed to select a FOTA file.

* The FOTA file can be selected from the Downloads folder. The file can be transferred to the device, either over
USB or by email.

* Android version 6.0 or higher is required.

RSL FOTA 10S LIMITATIONS

Note the following important details when using the RSL FOTA i0S Mobile Application:

¢ The RSL FOTA Mobile Application for iOS requires the Bluetooth Low Energy feature to be enabled to scan
for Bluetooth Low Energy devices.

* The easiest way to add a new FOTA file to the RSL FOTA Mobile Application is to send an email to the device
with the file attached. After downloading the file from the email, press the File icon once more, and a popup is
displayed where the user can select which app to use to open the file. Select the RSL FOTA Mobile
Application. The file is then imported to the application, and is visible when the user presses the Select File
button on the Update Firmware screen.
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CHAPTER 10

Performing FOTA Update with BLE Explorer

BLE Explorer is a desktop application that runs on Windows®, developed to work with the RSL10 USB Dongle.
BLE Explorer can be used to perform Firmware-Over-The-Air (FOTA) for onsemi RSL10 Bluetooth Low Energy
devices.

NOTE: Refer to the BLE Explorer Manual for instruction to update the firmware using BLE Explorer.
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Windows is a registered trademark of Microsoft Corporation. Arm, Cortex, Keil, and uVision are registered trademarks of Arm Limited (or its subsidiaries) in the US and/or elsewhere.
Bluetooth is a registered trademark of Bluetooth SIG, Inc. All other brand names and product names appearing in this document are trademarks of their respective holders.

onsemi and the onsemi logo are trademarks of Semiconductor Components Industries, LLC dba onsemi or its subsidiaries in the United States and/or other countries. onsemi owns the
rights to a number of patents, trademarks, copyrights, trade secrets, and other intellectual property. A listing of onsemi’s product/patent coverage may be accessed at
www.onsemi.com/site/pdf/Patent-Marking.pdf. onsemi is an Equal Opportunity/Affirmative Action Employer. This literature is subject to all applicable copyright laws and is not for resale
in any manner.

Copyright 2024 Semiconductor Components Industries, LLC (“onsemi”). All rights reserved. Unless agreed to differently in a separate onsemi license agreement, onsemi is
providing this “Technology” (e.g. reference design kit, development product, prototype, sample, any other non-production product, software, design-IP, evaluation board, etc.) “AS
|1S” and does not assume any liability arising from its use; nor does onsemi convey any license to its or any third party’s intellectual property rights. This Technology is provided only
to assist users in evaluation of the Technology and the recipient assumes all liability and risk associated with its use, including, but not limited to, compliance with all regulatory
standards. onsemi reserves the right to make changes without further notice to any of the Technology.

The Technology is not a finished product and is as such not available for sale to consumers. Unless agreed otherwise in a separate agreement, the Technology is only intended for
research, development, demonstration and evaluation purposes and should only be used in laboratory or development areas by persons with technical training and familiarity with
the risks associated with handling electrical/mechanical components, systems and subsystems. The user assumes full responsibility/liability for proper and safe handling. Any other
use, resale or redistribution for any other purpose is strictly prohibited.

The Technology is not designed, intended, or authorized for use in life support systems, or any FDA Class 3 medical devices or medical devices with a similar or equivalent
classification in a foreign jurisdiction, or any devices intended for implantation in the human body. Should you purchase or use the Technology for any such unintended or
unauthorized application, you shall indemnify and hold onsemi and its officers, employees, subsidiaries, affiliates, and distributors harmless against all claims, costs, damages, and
expenses, and reasonable attorney fees arising out of, directly or indirectly, any claim of personal injury or death associated with such unintended or unauthorized use, even if such
claim alleges that onsemi was negligent regarding the design or manufacture of the board.

The Technology does not fall within the scope of the European Union directives regarding electromagnetic compatibility, restricted substances (RoHS), recycling (WEEE), FCC, CE
or UL, and may not meet the technical requirements of these or other related directives.

THE TECHNOLOGY IS NOT WARRANTED AND PROVIDED ON AN “AS IS” BASIS ONLY. ANY WARRANTIES, EXPRESS, IMPLIED OR STATUTORY, INCLUDING BUT NOT
LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT, ARE HEREBY EXPRESSLY DISCLAIMED.
TO THE FULLEST EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL ONSEMI BE LIABLE TO CUSTOMER OR ANY THIRD PARTY. IN NO EVENT SHALL
ONSEMI BE LIABLE FOR SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY NATURE WHATSOEVER (INCLUDING, BUT NOT LIMITED TO, LOSS OR
DISGORGEMENT OF PROFITS, LOSS OF USE AND LOSS OF GOODWILL), REGARDLESS OF WHETHER ONSEMI HAS BEEN GIVEN NOTICE OF ANY SUCH ALLEGED
DAMAGES, AND REGARDLESS OF WHETHER SUCH ALLEGED DAMAGES ARE SOUGHT UNDER CONTRACT, TORT OR OTHER THEORIES OF LAW.

Do not use this Technology unless you have carefully read and agree to these limited terms and conditions. By using this Technology, you expressly agree to the limited terms and
conditions. All source code is onsemi proprietary and confidential information.

PUBLICATION ORDERING INFORMATION

LITERATURE FULFILLMENT: N. American Technical Support: onsemi Website: www.onsemi.com

Literature Distribution Center for onsemi 800-282-9855 Toll Free USA/Canada

19521 E. 32nd Pkwy, Aurora, Colorado 80011 USA Europe, Middle East and Africa Technical Order Literature: http://www.onsemi.com/orderlit
Phone: 303-675-2175 or 800-344-3860 Toll Free Support:Phone: 421 33 790 2910

USA/Canada For additional information, please contact your local
Fax: 303-675-2176 or 800-344-3867 Toll Free USA/Canada Sales Representative

Email: orderlit@onsemi.com
_______________________________________________________________________________________________________________|]
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